
10 conferences, 23 MVP awards, one Best of Business State Finalist 
Award, two National Finalist Training Awards, one Lifetime 
Achievement Award, one Finalist for Lifetime Achievement Award, 
10 books (with two in progress), 1,735 articles, 1,103 keyboard 
shortcuts, 132 readers’ questions and 4,642 pages and counting – 
that ’s right this newsletter hits 150! 
It's a three-fold celebration this month: our newsletter turns 150, an alumnus becomes a gameshow winner and Microsoft hits 50.

And then there are the regulars.

With no Power BI Updates last month, we have twice as many this time around!  There is the usual Beat the Boredom 
Challenge, Charts & Dashboards Tips, Over to AI, Excel for Mac, Visual Basics, Power Pivot Principles, Power Query 
Pointers, Excel Updates, plus we see the A to Z of Excel functions are not always PI in the sky!  Finally, we look at some 
simpler Keyboard Shortcuts to wrap up.

Happy reading and remember: stay safe, stay happy, stay healthy.

As we celebrate our own anniversary newsletter, let’s keep the positives 
coming!  Congratulations to SumProduct alumnus Myles Kuah who was 
named Sole Survivor and won season 10 of Australian Survivor Brains v 
Brawn II.

Self-proclaimed “Jungle Rat”, Myles proved exceedingly tenacious and 
popular on the recent TV series and exuded as much enthusiasm on the 
show as we saw in the workplace.  Those of you to catch Myles in the 

flesh in one of our AI training sessions will know exactly what we are 
talking about!

Now with big prize winnings to boot, Myles is presently revelling in his 
new-found fame and success and t-shirt merchandise!  We wish him all 
the best.  You never  know where he might pop up: he still narrates some  
of the AI training which you can check out on our website or email us  
about at training@sumproduct.com.

Hard to believe, but a Channel Ten image rather than a SumProduct staff photo!

Congratulations to Myles Kuah

NEWSLETTER #150 - May 2025
www.sumproduct.com  |  www.sumproduct.com/thought

Liam Bastick, Managing Director, SumProduct
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Microsoft Turns 50

Beat the Boredom Challenge

…And the celebrations come in threes!  In early April, Microsoft 
celebrated its 50th anniversary.  Given how reliant we are here on MS 
products (and in particular, Excel and Power BI), we tip our hat to the 
software giant.

“Just” a mere half-century ago, childhood friends Bill Gates and Paul 
Allen started Microsoft from a strip mall in Albuquerque, New Mexico.  
$3 trillion later, the company celebrates its 50th birthday as the second 
most valuable publicly traded company in the world behind Apple.

In all that time, Microsoft has only had three Chief Executive Officers in 
its history, two of whom are amongst the 11 richest people in the world 
due to their Microsoft fortunes (Steve Ballmer and Bill Gates).  Hope for 
us here at SumProduct!

We wonder what the next 50 years will bring…

With many of us currently “working from home” / quarantined, there are only so Zoom / Teams calls and virtual parties you can make before 
you reach your (data) limit.  Perhaps they should measure data allowance in blood pressure millimetres of mercury (mmHg).  To try and keep our 
readers engaged, we will continue to reproduce some of our popular Final Friday Fix challenges from yesteryear in this and upcoming newsletters.   
One suggested solution may be found later in this newsletter.  Here’s this month’s…

This month, we have a Power Query challenge for you.  We have received some expense information in an Excel workbook which is not in a format 
that is compatible with our usual layout, viz.

Therefore, this month’s challenge is to extract the data from a sheet in the supplied Excel workbook and present it in a Table that can be appended 
to other expense data.  The result should look like the Table below:
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Note: Our dates are in UK format – this is not part of the challenge (use whatever dates are “correct” in your part of the world)!

As always, there are some conditions:

	 •	 this is a Power Query challenge: no Excel formulae allowed

	 •	 the solution should allow us to add more expenses

	 •	 the solution should need less than 10 steps (one transformation per step)

	 •	 All the steps can be achieved using the User Interface (UI) from one query.  No M code is needed.

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

Here at SumProduct we write many articles for many magazines and our authoring contracts have been revised recently to ensure Artificial 
Intelligence hasn’t taken over our duties.  We can assure everyone they have not.  

But it did get us thinking: what if we did let AI loose and write a regular article for the newsletter?

This month, we asked AI what it thought was the current flavour of the month in Excel.

To be considered an expert financial modeller, it is crucial to have a 
comprehensive understanding of a wide range of Excel functions. These 
functions are the building blocks of robust financial models, enabling 
analysts to perform complex calculations, analyse data efficiently and 
present results in a clear, professional manner.  While there is no 

definitive number of functions one must know, mastering a core set of 
essential functions is imperative.

The core Excel functions for financial modelling are presented below.

This Month’s Prompt: How many Excel functions do you need to know to be considered an expert financial modeller?  Which functions do you need 
to know and why?  Why does knowing these functions make you an expert financial modeller?

1. Logical Functions

IF, AND, OR, NOT

Logical functions are fundamental in creating dynamic models that can adapt to different scenarios.  The IF function allows you to make logical 
comparisons and return specific values based on whether conditions are true or false.  Combining IF with AND, OR and NOT enables more complex 
logical tests and decision-making processes within your models.

2. Lookup and Reference Functions

VLOOKUP, HLOOKUP, INDEX, MATCH

These functions are essential for retrieving data from large datasets and different tables.  VLOOKUP and HLOOKUP are commonly used for vertical 
and horizontal lookups, respectively.  However, mastering INDEX and MATCH is crucial as they provide more flexibility and accuracy in data retrieval, 
especially in dynamic and multi-dimensional models.

3. Financial Functions

NPV, IRR, PMT, FV

Financial functions are indispensable for calculating key financial metrics such as net present value (NPV), internal rate of return (IRR), payment 
amounts (PMT) and future value (FV).  These functions help in evaluating investment opportunities, measuring profitability and performing various 
financial analyses.

Over to AI
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4. Statistical Functions

AVERAGE, MEDIAN, STDEV, VAR, CORREL

Statistical functions are used to summarise and analyse data distributions.  Functions like AVERAGE and MEDIAN provide measures of central 
tendency, while STDEV and VAR measure dispersion.  CORREL is useful for understanding the relationship between different variables, which is 
crucial in risk assessment and forecasting.

5. Text Functions

CONCATENATE, LEFT, RIGHT, MID, TEXT

Text functions are essential for manipulating and cleaning data.  CONCATENATE combines text from multiple cells into one, while LEFT, RIGHT and 
MID extract specific parts of a text string.  The TEXT function helps in formatting numbers and dates as text, ensuring that your data is presented 
clearly and consistently.

6. Date and Time Functions

TODAY, NOW, EOMONTH, YEARFRAC

Date and time functions are crucial for time-based calculations and projections.  TODAY and NOW return the current date and time, while EOMONTH 
calculates the end of a month.  YEARFRAC is useful for calculating the fraction of a year between two dates, which is important in discounting cash 
flows and other time-sensitive analyses.

7. Array Functions

SUMPRODUCT, TRANSPOSE, MMULT

Array functions are powerful tools for performing complex calculations on ranges of data.  SUMPRODUCT multiplies corresponding elements in 
arrays and returns the sum of the products.  TRANSPOSE changes the orientation of a range of cells and MMULT performs matrix multiplication, 
which is essential in advanced financial modelling techniques.

Why Knowing These Functions Make You an Expert

Mastering these Excel functions equips you with the skills to build accurate, flexible and insightful financial models.  Here's why:

	 •	 Accuracy and Efficiency: these functions help ensure that your calculations are precise and that you can perform complex analyses quickly

	 •	 Flexibility: understanding how to use these functions allows you to create dynamic models that can adapt to different scenarios and 	
		  inputs

	 •	 Professionalism: expert knowledge of these functions enables you to present data and results in a clear, polished, and professional 	
		  manner

	 •	 Insightful Analysis: these functions provide the tools necessary to conduct deep and meaningful analyses, helping you uncover insights 	
		  and make informed decisions.

By mastering these essential Excel functions, you will be well-equipped to tackle any financial modelling challenge with confidence and expertise.

Do you agree AI will get there this year?  Good to see VLOOKUP here 
again and deprecated functions like CONCATENATE and VAR!  And is 
SUMPRODUCT actually required with dynamic array formulae anymore..?  

I don’t use some of these functions so clearly, I’m no expert…  It will be 
interesting to see precisely what happens.  Send us your comments and 
ideas for questions to contact@sumproduct.com. 

Each month, we’ll cover a different topic to help you understand how Excel for Mac is different than Excel for Windows.  This month, in our series about 
Microsoft Excel for Mac, we show you some small differences in the way that filters work, why it’s that way and why it might be important to you.

The Filter dialog is a fundamental part of Excel and it’s used in numerous places – on ranges, tables / Tables and PivotTables.  Knowing how to filter 
your data is key, so keep reading to understand how filters work in Excel for Mac.

On Mac, you have an option for filter selections to take effect immediately 
or after you’ve finished making selections.  The default setting is for the 
filter to be updated immediately as you select values in the filter.  Unlike 
Excel for Windows, you don’t need to press OK to apply the filter.  Notice 

in our example below, the table behind the filter dialog becomes filtered 
immediately upon changing the selections.  If you disable the ‘Auto 
Apply’ setting, then you’ll need to press ‘Apply Filter’ when you’re ready.

Auto Apply

Excel for Mac
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When to Disable Auto Apply

In most cases, ‘Auto Apply’ won’t cause you any problem, but there are two [2] reasons you may wish to disable it:

	 1.	 Personal preference: you might find it distracting to see the filter applied as you make selections in the Filter dialog.  There’s no impact 	
		  to the final result of your filter choices, so it’s a personal preference.  If you don’t like seeing changes applied immediately, then just 	
		  disable the option

	 2.	 Performance: if you have a large amount of data to be filtered, you may notice a delay after each selection.  Excel may seem unresponsive 
		  for a short time.  If this happens, you can disable ‘Auto Apply’ and it should avoid any slowdowns while you’re making your filter 	
		  selections.

You should note that your choice for ‘Auto Apply’ will take effect for all workbooks and will remain in effect even after you quit and restart Excel.   
You can change it at any time by opening the Filter dialog.

We’ll continue next month…

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month, we continue our short series on some of the common traps we sometimes fall for.

This month, we’re going to highlight a common issue that arises when people record macros.  Suppose I have a list of employees and the salaries that 
they earn.  I want a macro that will copy the total salary from this table and paste it elsewhere in my worksheet.

In the image above, we are looking to copy the total in B4 and paste it as values in E1.  We can record a macro to do this.

Visual Basics
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Then, when we want to insert a new name into the list, we might run into issues…

Wait, what happened?  The macro did exactly as we asked it to: go to cell B4 and paste the value into cell E1.  The trick is to make the reference 
to the cells dynamic instead.  Instead of referring to cell B4, you can go to the target cell and set the Name of the cell to be something unique and 
relevant, for example:

Repeat the process for your target cell, then you can update your macro details accordingly:

A little clean-up goes a long way!

More next month…
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It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we look at creating 
a presentation of actual vs. target sales.

Let’s have some sales data for some imaginary salespeople:

We’d like to show this in a chart.  We may start by creating a basic column chart for our data.  We select the data and use ALT + F1 to insert a chart.

Charts and Dashboards

That’s okay, but it’s not really highlighting the achievements of our salespeople.  We’d like to show the actual sales within the target bars.  Let’s start 
by clicking on one of the bars for the Actual data series.
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We may then right-click and choose ‘Format Data Series’.

In the Format Data Series panel, we have the option to move our series to a ‘Secondary Axis’.

Let’s choose this option: the bars are overlapping, but it’s not making things any clearer yet!
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To continue formatting, we will select the Target data series and go back to the ‘Format Data Series’ pane.  This time, we are interested in the ‘Gap 
Width’ of the bars.

Let’s change the ‘Gap Width’ to 100%.

This is getting better: now we can see both bars.  The sizes are not in proportion because we have two different vertical axes.  We can delete the one 
on the right by selecting it and pressing DELETE.
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This is more like it.  Now we can work on the aesthetics.  Let’s pick a light green for the Target series and a dark green for the Actual series.  We can 
do this from the ‘Format Data Series’ pane.  We will use the ‘Transparency’ property to make the fill colour of the Target series lighter.

Let’s change the colour of the Actual series (with no transparency) and click and edit the ‘Chart Title’.

We can now see at a glance how well our salespeople are doing relative to their targets.  By picking light and dark colours, this would also be visible 
on a black and white printed document.  Next time, we’ll look at another way to show actual sales vs. target sales. 

More next month.
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We continue our series on the Excel COM add-in, Power Pivot.  This month, we look at the SUBSTITUTE function.

Last month, we looked at the REPLACE function and how it can be used to replace part of a string of text in a column.  However, we ran into a problem 
when we wanted to replace a string of text that existed in different positions in each row.  For example, if we consider the following dataset:

In this scenario, we want to replace “AB” with “New”.  Notice that the positions of “AB” in “Gloves AB” and “Vest AB” differ; “AB” is in the eighth 
character position in “Gloves AB” and is in the sixth character position in “Vest AB”.  In “Gloves AB”, we count each letter as a character position 
(including blanks), hence why “AB” is in the eighth character position.  When we create the following measure to replace “AB” with “New” using the 
REPLACE function:

=REPLACE(ProductTable3[Product Name],8,2, "New")

we end up with this result:

This is because the REPLACE function doesn’t necessarily ‘look’ for “AB”; it just replaces the old text starting from the specified starting character 
position.  Cue the SUBTITUTE function. 

Before we use the SUBSTITUTE function, we must understand how it works.  The SUBSTITUTE function, like the REPLACE function, replaces existing 
text with new text in text strings in every row in a column.  The SUBSTITUTE function is usually used to create calculated columns. 

The SUBSTITUTE function uses the following syntax to operate:

SUBSTITUTE(text, old_text, new_text, instance_num)

where:

	 •	 the text parameter is the string of text that contains the characters that we want to substitute; this can also refer to a column that 	
		  contains text

	 •	 the old_text parameter is the string of text that we want the function to look for in the text parameter

	 •	 the new_text parameter is the text string that is going to replace the old_text
	 •	 the instance_num is the instance which we want the old_text to be replaced by the next_text parameter if there are multiple old_text 	
		  strings found.

Going back to the dataset mentioned earlier, we can now use the SUBSTITUTE function to create the following measure: 

=SUBSTITUTE([Product Name],"AB","New",1)

Power Pivot Principles
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The SUBSTITUTE function has been able to replace all the “AB” text values with “New” without being affected by the different character locations.  
Let’s investigate the instance_num parameter.  Here, we’ve added another entry to our dataset:

Using the same DAX formula: 

Only the first instance of “AB” has been replaced in position six (6) of our dataset.  This is because we specified ‘1’ as our instance_num.  If we change 
the instance_num to ‘2’ we get: 

The SUBSTITUTE function now only replaces the second instance of “AB” it finds and ignores the first and last instance.  Keep this in mind when using 
the SUBSTITUTE function: changing the instance_num we specify which instance of the old_text we want to substitute. 
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Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from 
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we consider 
review how to view links in / on a webpage.

Unlike our usual Power Query article, we’re going to look at something 
a little different.  Presently, Power Query pretty much lives in the Power 
BI application, and some M functions are available from Power BI, but 
not necessarily – yet – supported when running Power Query from the 
‘Get & Transform’ section of the ‘Data’ tab.  If we need to work with 

webpages, then running Power Query from Power BI instead is very 
tempting. 

To access queries from Power BI, we use the ‘Edit Queries’ option:

Once in the Power Query Editor, we may choose to create a query from ‘New Source’ in the ‘New Query’ section on the ‘Home’ tab.  Let’s create a 
new Blank Query:

In our query, we are going to use two [2] M functions that are not available when we run Power Query from Excel.  The first is:

Web.BrowserContents(url as text, optional options as nullable record) as text

This returns the HTML for the specified url, as viewed by a web browser.  An optional record parameter, options, may be provided to specify 

additional properties. 

The second is:

Html.Table(html as any, columnNameSelectorPairs as list, optional options as nullable record) as table

This returns a table containing the results of running the specified columnNameSelectorPairs against the provided html.  An optional record 

parameter, options, may be provided to specify additional properties. 

We’re going to combine these functions.  To show what each one does, let’s use Web.BrowserContents() first.

Power Query Pointers

mailto:contact%40sumproduct.com?subject=
http://www.sumproduct.com
http://www.sumproduct.com/blog


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

By using

= Web.BrowserContents("https://www.sumproduct.com/")

we can see the contents of the (in)famous website, sumproduct.com.  Next, we need a step that will extract any links from this text:

This has been achieved using M code:

= Html.Table(Source, {{"Link", "a[href^=""http""]", each [Attributes][href]}})

We don’t claim to have an encyclopaedic knowledge of the CSS selectors needed for this functionality – but a list of CSS selectors can be retrieved 
with a quick search online.  This particular code searches all the <a> elements (as shown on the WebBrowserContents() example screen), where the 
href attribute begins ‘http’ (and so calls a link). 

We made this brief foray into Power BI territory because these functions are useful tools, which we hope to see in Excel’s Power Query / Get & 
Transform very soon (please?).

Until next month.
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After taking the month off last time, the Power BI updates are back with 
a vengeance with effectively a double dose.  This month witnesses a 
host of new features and improvements designed to enhance your data 
analysis and visualisation experience.  

Some of the highlights include Desktop start-up performance 
improvements, Copilot generated DAX queries using user-created 
hierarchies, create semantic models in Direct Lake storage mode, 
and improved language understanding for data questions and ad hoc 
calculation support for data questions.

Desktop start-up performance improvements

Microsoft has been working to improve Power BI Desktop’s start-up performance.  Starting with the March release, you’ll begin to see these 
improvements gradually rolled out.  In particular, you should note expedition in opening both blank reports and PBIX reports once the improvements 
have been bedded down.

Upgrade Power BI Desktop

You need to upgrade to the 64-bit version Power BI Desktop to keep receiving updates and support.  The 32-bit version will no longer be supported 
after 31 July 2025.

To continue using the Report view Copilot chat pane, upgrade to the February 2025 version.  It may not work as expected for versions before 
February 2025 after 30 April 2025.

The full list of updates is as follows:

General

	 •	 Desktop start-up performance improvements
	 •	 Upgrade Power BI Desktop
	 •	 Backward compatibility is impacted by Q&A setup updates

Copilot and AI

	 •	 Get a Copilot summary directly from your Teams message 	 	
	 	 with a single click
	 •	 Copilot in Power BI to write DAX queries in DAX query view 	
	 	 updates
	 •	 Improved language understanding for data questions
	 •	 Ad hoc calculation support for data questions
	 •	 Ad hoc calculation support for data questions now available in 	
	 	 Read mode

Reporting

	 •	 Better storytelling with Data annotations in Power BI for 	 	
	 	 PowerPoint (Preview)
	 •	 Copy report object name
	 •	 Referenced column highlights for visual calculations (Preview)
	 •	 Enhancements to Reference Lines
	 •	 Category enhancements for new card (Preview)
	 •	 Introducing style presets to visuals
	 •	 Insights category for business users in the OneLake catalog
	 •	 File picker enabled on by default in Power BI Desktop
	 •	 Mobile layout auto-create now Generally Available

Modelling

	 •	 Create semantic models in Direct Lake storage mode from one 	
	 	 or more Fabric artifacts in Power BI Desktop
	 •	 TMDL view support for Direct Lake semantic models (Preview)
	 •	 Updates to semantic model version history (Preview)
	 •	 Edit your data model in the Power BI Service – updates 	 	
	 	 (Preview)
	 •	 Live edit of semantic models in Direct Lake mode with Power 	
	 •	 BI Desktop – updates (Preview)
	 •	 Use notebooks with your semantic model (Preview)
	

	

	 •	 Access the Azure Analysis Services migration tool from your 	
	 	 workspace
	 •	 Table View improvements
	 •	 Distribution, discovery and consumption: CI / CD for Org Apps 	
	 	 (Preview)
	 •	 Introducing new customisation options for organisational 	 	
	 	 applications (Preview) – Combined Navigation
	 •	 Live edit of semantic models in Direct Lake mode with Power 	
	 	 BI Desktop updates (Preview)
	 •	 Semantic model changes with TMDL view (Preview)
	 •	 Azure Maps auto-zoom now includes reference layers
	 •	 Get ready for new Azure Maps tenant settings (coming soon)

Data Connectivity

	 •	 Improvement in Snowflake connector (Preview)

	 •	 Connect to the Vertica database with the user-installed ODBC 	
	 	 driver – updates (Preview)

	 •	 Use the built-in driver to connect to the Oracle (Preview)

	 •	 Another Snowflake connector update

Mobile

	 •	 View reports linked to a semantic model directly from Power 	
	 	 BI Mobile

Visualisations

	 •	 Drill Down Combo PRO by ZoomCharts
	 •	 Sunburst Chart by Powerviz
	 •	 Attribute Control Chart by Nova Silva
	 •	 Table with custom and grouped headers by JTA: a data 	 	
	 	 scientist’s visualisation tool
	 •	 Financial Reporting Matrix now with comments
	 •	 Drill Down Graph PRO by ZoomCharts
	 •	 TMap 3.0
	 •	 Lollipop Chart by Powerviz
	 •	 Strip Plot by Nova Silva.

Let’s look at each in turn.

Power BI Updates
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Microsoft has warned that they have introduced a “version bump to 
the linguistic schema underlying Q&A setup tooling”.  No idea what that 
means in English!  However, you should note that after installing this 
recent desktop release, if you continue to modify your linguistic schema 

in Q&A setup, such as synonyms, phrasings or suggested questions, you 
will not be able to open the PBIX files with older versions of the Power 
BI Desktop.  Watch out!

The Power BI preview message in Teams chat and Outlook has been 
extended to include a Copilot summary with the click of a button.  The 
new button, labelled ‘Open Copilot summary in Power BI’ opens the 
item alongside the Copilot summary.  This feature enables users to 
understand the content of a Power BI item more easily.

The button will be displayed for items that support Copilot and for users 
who have Copilot enabled.  This feature is available on all Teams and 
Outlook platforms, including desktop, browser and mobile.

Copilot in Power BI can now write DAX queries using user-created 
hierarchies and display folder names from the semantic model.  Including 
these in your model gives Copilot additional context about how to use 
your data and leverages existing data structures to accelerate and 
improve DAX queries.

For instance, you can reference measures grouped in a specific folder 
to be shown by a hierarchy, and Copilot will generate a DAX query 
with those measures by that hierarchy with a simple user request.  
Using hierarchies and display folders streamlines the process of writing 
complex DAX queries.  Especially in models with many measures or 
columns, display folders can help organise and logically group them.

Backward compatibility is impacted by Q&A setup updates

Get a Copilot summary directly from your Teams message with a single click

Copilot in Power BI to write DAX queries in DAX query view updates

mailto:contact%40sumproduct.com?subject=
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Columns and measures can be added to display folders using the Properties pane in the Model view.  

This is in addition to the recent updates allowing Copilot to understand your data better by using descriptions and synonyms on columns, tables and 
measures, and including sample values from columns. 

The Copilot capability for answering data questions from your model has 
also been improved.  This month includes enhancement of the language 
understanding layer by further leveraging a Large Language Model 
(an LLM) to interpret and understand common synonyms, phrasings 
and individual values in your model mentioned in your questions.  In 
summary, Copilot can now understand more of your questions out-of-
the-box!

Previously, certain questions required the report author to curate terms 
to ensure Copilot could correctly understand and answer accurately.  
Now, with the full power of an LLM, Copilot can understand significantly 
more questions out-of-the-box, saving the report author curation time 
and saving the Copilot user time clarifying common terms.

Improved language understanding for data questions

Before Now

Previously, Copilot struggled to understand that tea is a 
synonym for chai in the data without the report author 
adding this mapping to Q&A setup.

Now, Copilot understands this out-of-box because chai is a 
commonly known synonym for tea.
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Before Now

Previously, Copilot struggled to understand what ‘export’ 
could mean in relation to products and suppliers.

Now, Copilot understands this by default and saves the 
user a click to confirm this common relationship.

Previously, Copilot needed clarification for which instance 
value Ana refers to, even though there’s only one [1] match 
in the data.

Now, Copilot correctly understands and saves the user a 
click because there is one [1] Ana in the data, no need to 
clarify first to produce the answer.
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Ad hoc calculation support for data questions

Another major enhancement added to the Copilot capability for answering data questions from your model is ad hoc calculation support.  Previously, 
if your question required creating new measures on the fly, not contained in the model, like a calculated column for profit or deriving the average, 
Copilot would not be able to respond.

This update brings over the same DAX query generation capability from DAX query view to the Copilot pane.  Now, Copilot pane can generate DAX 
queries to answer questions that require ad hoc calculations.

Examples of questions might include:

	 •	 What was the year-over-year growth for sales?

	 •	 How many employees were hired before 2025?

	 •	 Calculate the ratio of cosmetic product orders to all products

	 •	 Which customers did not buy any products?

You can also verify the DAX query directly from the expanded view or launch DAX query view for further inspection.

It should be noted that this was originally only available from Edit Mode of reports using Copilot and was not yet available whilst using Copilot in 
Read mode.  However…
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Ad hoc calculation support for data questions now available in Read mode

Better storytelling with Data annotations in Power BI for PowerPoint (Preview)

Given the double hit of updates this month, Microsoft has now also added ad hoc calculation support to the Copilot capability for answering data 
questions from your model.  

Microsoft has also announced a public Preview of the new enhancement that allows users to make their presentations even more engaging by adding 
data point annotations to the visuals incorporated into their slides.

mailto:contact%40sumproduct.com?subject=
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Annotations enable users to add descriptive text directly to 
visualisations, offering contextual explanations or highlights that 
improve communication and understanding.  This feature transforms 
data storytelling by allowing users to communicate insights with 
greater efficacy and enhance the engagement and informativeness of 
presentations.

To utilise annotations, you first need to embed a single visual within the 
add-in in a slide.  Then, simply select a data point on the visual, right-
click, and choose ‘Annotate’.  You can then begin typing your text.  You 
may reference the data point’s measure value and category values in the 
annotation, ensuring the content is connected to the actual data point.  
Typing ‘/’ provides options that can be included in the annotation text.

Annotations will display whenever the data point is visible.  If the visual is filtered, resulting in the disappearance of the data point, the annotation 
will likewise disappear.  Additionally, if the data updates and the data point is no longer part of the visual, the annotation will not be shown as well.

Annotations are specific to the presentation and slide where the visual was added, allowing you to provide content that is truly in the context of your 
presentation.

It should be noted:

	 •	 Annotations are not supported in custom visuals

	 •	 Annotations are supported in all Power BI native Cartesians visuals

	 •	 Annotations are available only when embedding a single visual view and not a page view.
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Copy report object name

The Power BI enhanced Report format (PBIR) saves the entire report definition as a folder, with each visual, page and bookmark getting saved into 
its own individual file.  However, identifying the folder or file in the file system can be challenging, especially for visuals.

You now have the option to activate a global report setting in Power BI Desktop, enabling the ability to copy any report object name (including pages, 
visuals, bookmarks and filters) to the clipboard.  Go to File -> Options and settings -> Report settings -> Report objects and check the box next to 
‘Copy object names when right clicking on report objects’.

Once the setting is enabled, right-clicking on any report object will present the option ‘Copy object name’, which copies the object name to the 
clipboard.
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You can subsequently enter the name into the search bar of Windows Explorer or Visual Studio Code to efficiently locate or identify the object name 
within the PBIR folder:

It is also possible to copy the report object name within the service during report editing.  To do so, you must first enable the report user setting: 
open any report settings and enable the ‘Copy object names when right clicking on report objects’ option (while it’s configured per report it’s a user 
setting, you don’t need to enable it for each report).
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When editing a report, you now have the capability to right-click on any report object and copy its name:

This functionality is beneficial not only for identifying file names in PBIR file format, but also for performance troubleshooting through Workspace 
Monitoring or Log Analytics to link the DAX query to a visual in the report.

For example, you can easily find the DAX query of a visual by searching for its visual name:
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Referenced column highlights for visual calculations (Preview)

If you are struggling with DAX calculations, visual calculations are here to help to make adding calculations easier and faster.  Visual calculations now 
include referenced column highlights to indicate the columns referred to in your visual calculation.  These highlights, akin to those in Excel, will show up 
in the visual matrix as soon as a column is referenced, and the reference in the visual calculation formula will be marked with the corresponding colour. 

For example, let’s create a visual calculation that calculates the running sum of Sales Amount and resets for every year:

Running Sum = RUNNINGSUM([Sales Amount], [Fiscal Year])

When editing this visual calculation, the related column headers are highlighted:

Additionally, the referenced column highlights can be turned off and on using the matrix highlights toggle that is on the right of the Formula bar in 
visual calculations edit mode:

It is located on the right of the Formula bar in visual calculations edit mode.

Apparently, this is only the beginning of making visual calculations even easier to use, so stay tuned for more!

Enhancements to Reference Lines

These updates have now improved feature parity for reference lines.  You can add shade areas for all reference line types:

When the reference line position is set to ‘behind’, the shade area will also be moved behind the chart.
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When the reference line position is set to ‘behind’, the shade area will also be moved behind the chart.

For Line and Stacked Column and Line and Clustered Column charts, Power BI now supports reference lines on the y-axis.  Dynamic reference lines 
(Min, Max, Average, etc.) are only available for Line and Clustered Column charts.

The new card visual is steadily progressing towards becoming the official 
card, which will replace both the current card and multi-row card.  This 
update introduces additional enhancements for categories, previously 
known as small multiples.

Power BI is also introducing two [2] new styles for categories: table 
style and cards style.  The new cards style will split each category into a 
separate card, providing a more organised and visually appealing layout.  
Each style option comes with its own settings, which you can find under 
small multiples layout -> Layout -> Styles.

Category enhancements for new card (Preview)

mailto:contact%40sumproduct.com?subject=
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Small multiple headers for the new card visual can be placed on the left, top, right or bottom.

he titles of the small multiple headers can be oriented to the left, top, right or bottom.

You can now apply conditional formatting to elements of your new card based on the logic of each category.

mailto:contact%40sumproduct.com?subject=
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Remember, the new card visual is still in preview, to enable this new visual, follow these steps:

	 •	 Go to File -> Options and settings -> Options
	 •	 Navigate to Preview features

	 •	 Check the option for new card visual.

Introducing style presets to visuals

Style presets are predefined formatting options that can be applied to visual elements using a custom theme file.  Users may now create personalised 
style presets.  This new feature allows users to change multiple formatting options simultaneously while eliminating the need to manually change 
each formatting option individually.

By creating and importing a custom JSON theme 
file that includes your desired style presets, you’ll 
unlock a new Style presets menu option within 
the ‘Format Visual’ section of the Visualizations 
pane.  Utilizing the Style dropdown, you can easily 
select any of your predefined style presets from 
the newly imported theme file to automatically 
apply formatting options to visual elements in 
their report, such as positioning elements or 
altering colours.
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When crafting a custom theme file, users can specify which style preset 
will be the default after importing, as shown here.  If no preset is selected 
or defined, Power BI’s default settings will be applied, ensuring there are 
always fallback formatting options for visual elements.

In the following example, Demo Preset 1 sets the legend position to the 
bottom centre and changes the gridline colour of the value axis.

In this next example, Demo Preset 2 moves the legend to the right side and changes the gridline colour and the label colour of the value axis.

An error condition will occur, as shown below, when the theme is changed, causing the report to lose the reference to the preset definitions.   
This results in an author-only error message indicating that the preset cannot be found.
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Insights category for business users in the OneLake catalog

File picker enabled on by default in Power BI Desktop

Mobile layout auto-create now Generally Available

The ‘OneLake catalog’ is a centralised platform that allows users to 
discover, explore and manage their data assets across the organisation.   
It simplifies data governance and enhances accessibility, ensuring that 
business users, analysts and data professionals can quickly locate and 
utilise the resources they need. 

Business users now have a dedicated Insights category, bringing together 
a comprehensive view of their key analytics assets.  This category includes 
Reports, Dashboards, Organizational Applications (Apps), Fabric Insights 
such as Real-time Dashboards and AI Skills, and more.  With this new 
category, users can discover actionable insights tailored to their data, 
improving decision-making and overall analytics engagement.

Back in January, Microsoft announced an updated file picker experience 
in Power BI Desktop.  With this release of Power BI Desktop, the file 
picker will be enabled to be on by default.  If you would like to revert to 

the old file picker experience, you may do so by navigating to options 
and settings and deselecting the updated file picker experience from the 
list of Preview items.

Mobile-optimised report layouts provide an optimal way to view data in 
Power BI mobile applications.  Previously, creating such layouts required 
additional effort.  However, this is no longer the case.

The mobile layout auto-creates is now Generally Available: you can 
generate a mobile-optimised layout with a click of a button.  This feature 
allows you to easily create mobile-optimised layouts for any new or 
existing report page, saving you time.

When you switch to the mobile layout view in Power BI Desktop, if 
the mobile canvas is empty, you can generate a mobile layout just by 
selecting the Auto-create button.

The Auto-create engine understands the desktop layout of your report 
and builds a mobile layout that considers the position, size, type and 
order of the visuals that the report contains.  It places both visible and 
hidden visuals, so if you have bookmarks that change a visual’s visibility, 
they will work in the automatically created mobile layout as well.

You can edit the automatically created mobile layout, so if the result is 
not exactly what you expected, you can tweak it to make it perfect for 
your needs.  Think of it as a starting point you can use to shorten the way 
to that effective, mobile-optimised report you envision.
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Create semantic models in Direct Lake storage mode from one or more Fabric artifacts in Power BI Desktop

The public Preview of creating semantic models using Direct Lake 
storage mode in Power BI Desktop has also been announced.  Direct Lake 
unlocks massive data with quick query performance without having to 
manage data refreshes and without causing data duplication.  For the 
first time with Direct Lake semantic models, you can add tables from 

multiple OneLake data sources, giving you the flexibility to combine data 
for your needs to create your Power BI reports.

You may create these Direct Lake semantic models in just a few clicks 
in Power BI Desktop.  With the Preview feature turned on, select a 
Lakehouse or Warehouse from the ‘OneLake catalog’ and then ‘Connect’.

Direct Lake semantic models read the OneLake data directly and are created in the workspace.  Give the semantic model a name, pick a workspace 
and select the tables you want to include, and then click OK.

The semantic model is created in the workspace and you will now be live editing the semantic model in Desktop.
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To bring in other tables, return to the ‘OneLake catalog’ and pick another 
Lakehouse or Warehouse.  Similar to when you created the semantic 
model, just pick a Lakehouse or Warehouse and click ‘Connect’.  It’s 

added to the semantic model.  You may also add relationships, measures, 
calculation groups and hierarchies.  DAX query view is also available to 
view data in the tables and try out calculations.

TMDL view support for Direct Lake semantic models (Preview)

Updates to semantic model version history (Preview)

You can now use the Tabular Model Definition Language (TMDL) view to edit your semantic model in Direct Lake mode.   TMDL view not only can provide 
a code-first semantic modelling experience but also enable unique scenarios, such as altering the Lakehouse connected to the semantic model.

The Preview of semantic model version history is coming soon and will 
include support for Pro workspaces.  This feature aims to empower self-
service users by providing confidence to recover from critical mistakes 
when editing semantic models on the web.  In this Preview, versions will 

be automatically captured in an Office-like history pane for your web-
edited semantic models.  You can easily select and restore any of these 
previous versions of your semantic model.

Please note that if you rename or remove an object using TMDL view, it is essential to include Power BI metadata annotations changed Property 
and PBI_RemovedChildren to ensure your customisations are retained the next time you synchronise your Direct Lake semantic model with the 
Lakehouse.
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Additionally, you have the option to manually save versions to the version history for your semantic model.

Edit your data model in the Power BI Service – updates (Preview)

Live edit of semantic models in Direct Lake mode with Power BI Desktop – updates (Preview)

With the release of semantic model version history for pro workspaces, 
Microsoft will start enabling the workspace-level Preview feature for 
editing data models in Power BI Service shortly.  The Users can edit 
data models workspace setting will be turned on by default for Pro 
workspaces.  If you prefer, you can still disable the workspace preview 

for your workspace, but it is recommended to keep it enabled.  Power BI 
administrators will still have the ability to enable or disable data model 
editing in the Service for the entire organisation or specific security 
groups through the admin portal.

In this update you can now seamlessly open your Direct Lake semantic 
models for editing in Power BI Desktop directly from the web.  Just like in 
Office products, simply select the ‘Edit in Desktop (preview)’ option from 

the web to launch Power BI Desktop with the same Direct Lake model 
open and you will be ready for editing.
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Use notebooks with your semantic model (Preview)

One-click experiences have been introduced that make it easier than 
ever to start using Fabric notebooks and semantic link to analyse your 
semantic models on the web.  Simply choose one of Microsoft’s pre-

configured notebooks and the software will handle the creation and 
configuration, allowing you to run analysis against your semantic model.

Microsoft is also offering the following out-of-the-box experiences for your semantic models:

	 •	 Best Practice Analyzer: when you run this notebook, the ‘Best Practice Analyzer’ (BPA) will offer tips to improve the design and 		
		  performance of your semantic model.  By default, the BPA checks a set of 60+ rules against your semantic model and summarises the 	
		  results.  These rules come from experts within Microsoft and the Fabric Community.  You’ll get suggestions for improvement in five [5] 	
		  categories: Performance, DAX Expressions, Error Prevention, Maintenance and Formatting

	 •	 Memory Analyzer: when you run this notebook, the ‘Memory Analyzer’ will show you memory / storage statistics about the objects 	
		  in your semantic model (i.e. Tables, Columns, Hierarchies, Partitions and Relationships).  These statistics may be used to identify areas of 	
		  performance optimisation and memory reduction for your semantic model.
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Additionally, take note of the new Power BI Community notebooks gallery too.  Here, you may explore and submit notebooks you’ve created to 
enhance your Power BI data analysis and reporting with the rest of the Power BI community.

You can now access the Azure Analysis Services (AAS) migration tool 
from your Fabric workspace by clicking the ‘Migrate’ button and selecting 
the ‘Data model’ card.  The AAS migration is an easy-to-use migration 
solution that enables the migration of models from AAS servers to 
workspaces in Fabric.  

It allows customers to migrate their models at a click of a button, as 
well as utilise server redirection capabilities to automatically redirect 
client-tool connections from an existing AAS server to a model residing 
in Fabric.  This creates a migration experience that reduces the impact 
to downstream users, reports and automation processes, allowing 
customers to leverage the capability suite of Power BI and Fabric.

To get started:

	 •	 Migrate Azure Analysis Services to Power BI

	 •	 Migrate from Azure Analysis Services to Power BI Premium

	 •	 Migrate from Azure Analysis Services to Power BI Premium: Migration scenarios.

Access the Azure Analysis Services migration tool from your workspace
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Microsoft has made new improvements to the Table View in Power 
BI Desktop.  Now, simply right-click on any cell to access a variety of 
options, including copying the entire table, a specific column, just the 

cell’s value or using keyword shortcut of CTRL + C for the values.  With 
this update, you can extract individual cell values directly, eliminating 
any need for extra steps and making your workflow more efficient.

Support for Fabric Git integration and deployment pipelines for org apps 
is now in Preview.

With Git, you can develop and version organisational applications (“org 
apps”) with ease.  Org app developers may manage and version org apps 
based upon their development processes.

With deployment pipelines, you can test and deploy org apps with 
confidence.  Org app authors and developers can develop, test and 
review in staged workspaces before deploying to final production 
workspaces, with user access uniquely managed per org app item in each 
staged workspace.

With continuous integration (CI), Git integration Microsoft Fabric 
empowers org app developers to seamlessly integrate their development 
processes, tools and best practices directly into the Microsoft Fabric 
workspace.  Setting up Git is as easy as a couple of clicks.  Configure 

the Git repository and branch details in the workspace settings to set up 
a connection.  Once set up, commit org app changes with confidence, 
knowing you can version or branch as you iterate on org app items and 
included items in your workspace.

Table View improvements

Distribution, discovery and consumption

GIT INTEGRATION FOR ORG APPS (CONTINUOUS INTEGRATION): CI / CD for Org Apps (Preview)
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Git enables org app developers to:

	 •	 backup and note the version of their org app item, along with included items

	 •	 see version history and revert to previous versions of org apps and included content as needed

	 •	 collaborate on org apps with others or iterate on your own using Git branches

	 •	 automate or script tasks around your processes.

Items included in an org app (Preview), like reports, use the source item 
in the workspace for display in the org app, unlike workspace apps that 
display versioned copies of included items after workspace app update.  
To date, workspace applications have allowed report authors to iterate 
on reports across just two [2] stages without impacting the published 
copy of the report in a workspace application.

Now, with deployment pipelines support for org app items, you can 
create, manage and deploy in stages that match your workflow.  
Compared to workspace applications that support just two [2] stages, 
org apps support for deployment pipelines gives you the flexibility to add 
several stages based on your needs.

Microsoft is continuing to enhance your ability to customise org apps with 
the release of the combined navigation setting.  This new functionality 
allows org app authors to have more control over their consumer 
experience by offering several navigation configurations.

Previously, org apps had separate navigation panes: one for the org app 
itself and another for the report in view.  With the combined navigation 

experience, you can now choose to show a single pane with report 
pages within the app navigation pane, eliminating the need for two [2] 
separate navigation panes.  This means that the pages of reports will 
be shown underneath the reports listed in the org app navigation pane, 
providing a more streamlined and cohesive user experience.

DEPLOYMENT PIPELINES FOR ORG APPS (CONTINUOUS DEPLOYMENT [CD])

Introducing new customisation options for organisational applications (Preview) – Combined Navigation

For example, after changes have been finalised, Fabric deployment pipelines enable org app authors or developers to automate or manually control 
the deployment of changes across different workspaces used for:

	 1.	 Development

	 2.	 Testing

	 3.	 Review

	 4.	 Production stages.

Deployment pipelines enable org app authors and developers to:

	 •	 ensure that org apps are in synchronisation with earlier stages

	 •	 verify and deploy changes quickly and reliably

	 •	 use ‘Select related’ to ensure items included in the org app are also promoted during deployment

	 •	 reduce the risk of errors and conflicts that might arise from manual interventions or inconsistent configurations

	 •	 compare org apps across different environments

	 •	 ultimately, ensure the delivery of quality org app experiences to your org app consumers.

Deployment pipelines empower teams to produce updates in short cycles with high speed, frequency and consistency.  Changes can be promoted 
at any time with a single click.
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Covered in the original org apps (Preview) announcement, org apps 
offer a level of customisation beyond workspace apps.  By adding 
this new combined navigation option you can customise an org app 
even more.  Starting with whether you prefer to have the org app 
navigation collapsed or expanded by default.  You may even turn off 
the org app navigation completely.  For those who prefer to show org 
app navigation, the combined navigation experience offers additional 
flexibility and control.  Alternatively, when a report is in view, you can 
choose to show a separate navigation of pages in the report.  You can 
explore these configurations and other combinations for your org apps.  

This level of customisation ensures that you can create a unique and 
tailored experience for different groups within your organisation.

This new option of combining the org app navigation and report 
navigation is like the previous version of org apps offered, known as 
workspace apps.  Workspace apps allowed for a unified navigation 
experience and the combined navigation experience in org apps builds 
on that foundation by providing even more customisation options.  
By combining the navigation panes, org app consumers can enjoy a 
seamless and efficient way to access and interact with data in your org 
apps that may be familiar to them from workspace apps.

Live edit of semantic models in Direct Lake mode with Power BI Desktop updates (Preview)

Coming soon, the changes you make to layouts for your Direct Lake model will persist and be displayed consistently between Desktop and the 
Service, specifically:

	 •	 changes made to Direct Lake semantic model layouts in Desktop will be reflected when opening the same model in the Service

	 •	 changes made to Direct Lake semantic model layouts in the Service will be reflected when opening the same model for live editing in 	
		  Desktop.

TMDL view allows you to preview script changes by showing a preview 
of the semantic model before and after script execution as a TMDL 
code diff.  For the uninitiated, a “TMDL diff” refers to a comparison or 
difference between two versions of a TMDL, often used to track changes 
or progress made in implementing the plan.  This is particularly useful 

when copying scripts from others, allowing you to assess their impact 
before running them against your semantic model.

Clicking the Preview button next to Apply shows a TMDL diff of the 
semantic model before and after executing the TMDL script in the 
opened tab:

The fields in red and green highlight the changes; red for removed and changed lines and green for new changes.

The preview is read-only, but you can keep editing your script.  To refresh the preview after changes, click ‘Update preview’.

Semantic model changes with TMDL view (Preview)
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The top right toolbar lets you navigate code diffs, switch between inline or side-by-side views, hide unchanged regions and close the preview.

The Azure Maps Visual now includes an auto-zoom feature that 
automatically zooms into areas where reference layers are plotted.  
When users apply slicers, the visual will zoom directly into the filtered 

polygons, allowing for faster navigation and improved focus on relevant 
geospatial data.  This enhancement significantly boosts efficiency and 
helps users quickly gain insights from their maps.

This will be the new default experience, but you can always turn it off using the new ‘Include reference layer’ option in the View card of the Map 
settings section of the Formatting pane.  For existing map visuals, you’ll need to enable the feature manually.

Azure Maps auto-zoom now includes reference layers
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Beginning in June, Power BI will introduce new tenant settings for 
the Azure Maps visual, giving you more control over data residency 
and compliance.  These more granular tenant settings will let you 
independently control:

	 •	 whether data can be processed outside your tenant’s 		
		  geographic region

	 •	 the use of certified Microsoft Online Services sub processors 	
		  (used by the selection tool).

However, to take advantage of these changes, there is an important 
step: your organisation must be on the April version of Power BI Desktop 
(this release) or later.

If you’re still using an older version of Power BI Desktop in June, Azure 
Maps visuals will no longer work in your reports when viewing them 
in Desktop.  Don’t wait: upgrade now to be ready for the enhanced 
governance controls and avoid disruptions.

Improvement in Snowflake connector (Preview)

This month, Power BI continues to enhance this connector to further boost its performance to provide better experience.  You can upgrade to the 
latest version to evaluate these enhancements.

Use the built-in driver to connect to the Oracle (Preview)

This month Microsoft is introducing a new option for getting data from the Oracle database using a built-in Oracle driver, currently available in 
Preview.  This feature removes the necessity for users to install and manage the driver, allowing you to utilise the Oracle managed ODP.NET driver 
included with Power BI Desktop.

Another Snowflake connector update

Starting from the March 2025 version of Power BI Desktop, the ‘New Snowflake connector implementation’ option is enabled by default, so that all 
the newly created connections utilise ADBC to connect to Snowflake.  Your existing connections will remain unchanged.

Previously, Microsoft added support to view semantic models from the Power BI Mobile 
apps, so users would be able to track the model status and trigger on-demand refresh 
when needed.  Now, the company is adding to the semantic model the ability to see which 
reports are connected to it as well.

Understanding which reports were created from a semantic model in Power BI is crucial 
for several reasons.  It ensures the consistency and reliability of the data being used 
across different reports.  When users know that the reports are linked to sa common 
semantic model, they can trust that the metrics and calculations are standardised.  This 
is particularly important in collaborative environments where multiple stakeholders rely 
upon accurate data to make informed decisions.

To see the connected reports, open any semantic model in the app, and select ‘Linked 
content’ from the information pane.  You can now view related reports you have access to, 
including those from different workspaces.  The origin workspace of each report is shown 
below its name.

View reports linked to a semantic model directly from Power BI Mobile

In February 2025, a new option was introduced to Power BI to use the 
user-installed ODBC driver to connect to Vertica database.  With this 
release of Power BI Desktop, this option will be enabled by default, you 
will need to install the ODBC driver on your machine to use the Vertica 
database connector in Power BI Desktop.

If you would like to revert to the old built-in driver experience, you can 
navigate to ‘Options and settings’ and deselect the ‘Use user-installed 
Vertica ODBC driver’ option.

Connect to the Vertica database with the user-installed ODBC driver – updates (Preview)

Get ready for new Azure Maps tenant settings (coming soon)
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Combo PRO is a multi-tool for visualising categorical data.  You may 
combine up to 25 series on the same chart, choose between three [3] 
chart types for each series and create stacks and clusters to build the 
perfect visual for your report – even chart types like Clustered Column 
charts, Histograms, Lipstick charts and many others.

Furthermore, you can create a category hierarchy with multiple columns, 
which will allow you to drill down with just a click or tap directly on the 
chart.  Combo PRO provides intuitive user experience with full touch 
support, and it cross-filters with other visuals to provide instant insights 
that enable swift and fully informed decisions.

Main features include:

	 •	 combine up to 25 series of columns, lines, and areas

	 •	 vone-click drill down

	 •	 intuitive on-chart interactions

	 •	 split by ‘Legend’

	 •	 show additional insights with the ‘ToolTip content’ field

	 •	 rich customisation (axes, series, legends, labels, ToolTips and more)

	 •	 up to four [4] threshold lines or areas

	 •	 conditional formatting.

Drill Down Combo PRO by ZoomCharts
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Sunburst Chart by Powerviz

Powerviz’s Sunburst Chart is an interactive tool for hierarchical data visualisation.  This chart visualises multiple hierarchy columns, revealing part-to-
whole relationships with a concentric circle design.

Key features include:

	 •	 Arc customisation: customise arc shape, patterns and formatting for unique designs

	 •	 Colour scheme: 30+ colour palettes, including colour-blind safe mode

	 •	 Centre circle: design an inner circle with layers.  You may add text, measures, icons and images

	 •	 Ranking: filter Top / Bottom N values, with “Others”
	 •	 Conditional formatting: easily identify outliers based upon measure or category rules

	 •	 Labels: smart, readable data labels inside or outside shapes

	 •	 Image labels: add an image as an outer label

	 •	 Interactivity: zoom, drill down, cross-filtering and ToolTip features

	 •	 Sequences: clearly view which level is being explored
	 •	 Control ToolTip visibility: add and apply ToolTips globally or by level.

Other features included are annotation, grid view, show condition and accessibility support.

Business use cases include:

	 •	 Sales and marketing: market share analysis and customer segmentation

	 •	 Finance: departmental budgets and expenditures distribution

	 •	 Operations: supply chain management

	 •	 Education: course structure, curriculum creation.

Try Sunburst Chart for FREE from AppSource.
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Attribute Control Chart by Nova Silva

Earlier this year, Nova Silva introduced the Attribute Control Chart for Power BI, designed to empower users with advanced quality control insights.  
Initially, it supported the foundational attribute chart types, including the c chart, u chart, Laney u chart, p chart, Laney p chart and np chart.

Now, expanded capabilities have been announced with support for Rare 
Event Control Charts — specifically, the T chart and G chart.  These charts 
are essential for monitoring events that occur infrequently, allowing for 
more nuanced control in scenarios where traditional control charts may 
not be sensitive enough.  The T chart helps monitor the time between 
rare events, while the G chart tracks the count of opportunities between 
events.  These new additions make the Attribute Control Chart even 

more versatile, enabling organisations to gain insights into low-frequency 
incidents, which are often critical yet challenging to monitor.

By expanding Power BI’s Attribute Control Chart functionality, Power 
BI continues to support diverse business needs, helping teams identify 
issues promptly and maintain high-quality standards across all processes.

You can download it from AppSource and try it for free.

Table with custom and grouped headers by JTA:  
a data scientist’s visualisation tool

This visual allows you to create structured tables while 
grouping columns under custom headers that act like 
categories, improving readability and making complex 
datasets easier to analyse.

Key features include:

	 •	 Custom header grouping: organise column 	
		  headers into general and sub headers for better 	
		  structure

	 •	 Hierarchical row display: present rows in a 	
		  hierarchical format and control which levels to 	
		  collapse or expand

	 •	 Flexible column organisation: group columns 	
		  under sub headers and main headers for 	
		  improved clarity

	 •	 Adjustable header visibility: hide general  
		  headers whilst keeping sub headers visible

	 •	 Table totals display: show or hide totals for  
		  better summarisation

	 •	 Advanced formatting options: Customise  
		  background and font colours for specific headers

	 •	 Display unit formatting: adjust numerical values  
		  to suit your reporting needs.

This may be downloaded for free from AppSource.

mailto:contact%40sumproduct.com?subject=
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Making financial statements with a proper layout has just become easier 
with the latest version of the Financial Reporting Matrix.  Starting from 
version 8.1, you can now add comments to the cells, explaining the 
values to the readers.

Cells containing a comment will show an indicator like what you are used 
to seeing in Excel.  The visual will also show comments indicator, marked 
with red, on how many comments are present with the current filter 
context.

Financial Reporting Matrix now with comments
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Click the comment indicator, select a cell, and write your comment, it’s as easy as that!

The new version also includes:

	 •	 Support for Power BI Tooltips, including using Report pages as ToolTips
	 •	 Improved conditional formatting options: name your formatting steps and with the new ‘custom’ style option you are no longer limited 	
		  by the number of unique styles you can apply

	 •	 Data limit: the default has been 3,000 rows, now the developer is free to adjust that to a maximum of 30,000 rows.  The trade-off can be 	
		  the performance of the visual – so use it with caution.

This is in addition to the already existing features of the Financial Reporting Matrix:

	 •	 Adding custom rows

	 •	 Applying company / customer specific themes

	 •	 Expand / collapse columns

	 •	 Conditionally hide columns.

Highlighted new features:

	 •	 Data limit

	 •	 Commenting

	 •	 Conditional formatting

	 •	 ToolTips – Report page.

You can download it from AppSource and try it for free.
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Drill Down Graph PRO by ZoomCharts

You can visualise your graph-structured data in an interactive way with Drill Down Graph PRO.  This visual combine powerful data analysis 
capabilities with user-friendly UI, incredible configurability and seamless cross-filtering.  Benefits include:

	 •	 Graph data structure: Graph PRO will identify relationships between source nodes and target nodes and connect related nodes with links
	 •	 Focus nodes: simplify complex graphs by assigning ‘focus node’ status to specific nodes.  You can then choose to initially display only 	
		  focus nodes, allowing the user to expand them on-demand

	 •	 Multiple layouts: choose between five [5] layout modes: Dynamic (force-directed), Big Data Dynamic, Hierarchy, Radial and Static.  You 	
		  can also enable a toolbar button so users can switch layouts on-the-fly

	 •	 Full customisation: enjoy full control over the look and feel of your graph, including navigation, legends, labels, nodes, links, ToolTips and 	
		  more.  You can also create nodes and link categories in data to apply separate appearance settings for each

	 •	 Auras: visually highlight node groups (even if they are not linked directly) with colourful auras
	 •	 Data-driven customisation: use various optional fields to provide label and ToolTip content, and apply customisation rules to nodes and 	
		  links (including colour, shape, size, images and more).

You can download it from AppSource and try it for free.
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TMap 3.0

The newly released TMap 3.0 has added new features for combining a symbol or chart with choropleth map to create symbol choropleth map or 
chart choropleth map.  Combining proportional symbols and choropleth Map into one map will help data professionals to explore insights at both 
regional and individual location level just from one visual.
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This Symbol Choropleth Map shows population for census metropolitan areas and their summation for each province in Canada.  Combining charts 
and choropleth map will help to explore spatial correlations among many variables through multivariate geovisualisation.

This Chart Choropleth Map shows relations between GDP and population across six [6] continents.

A top marker layer, a linked polygon layer and five [5] reference layers can be added to the TMap visual to make various thematic maps to explore 
geospatial and business intelligence.  The data source for the linked polygon layer can be WKT (Well-Known Text) data in data model or built-in 
boundary data inside the visual or uploaded shape / geojson file.

Again, this may be downloaded from AppSource.

Lollipop Chart by Powerviz

The Powerviz Lollipop chart is a variation of a Bar chart that uses lines and 
dots to represent data points.  It is useful for highlighting specific trends to 
help stakeholders make informed decisions.

Key features include:

	 •	 Chart options: easily switch between vertical / horizontal chart
	 •	 Marker style: choose from Shapes, Charts, Icons, Images or 	
		  upload a custom image

	 •	 Reference lines / bands: add reference lines and bands to 		
		  highlight values easily

	 •	 Small multiples: split your visual into multiple smaller visuals

	 •	 Fill patterns: highlight nodes with patterns or upload your own
	 •	 Race chart: enhance the chart by adding animations to show 	
		  data changes over time

	 •	 Cut / clip axis: trim / adjust the axis to accommodate the 		
		  outliers

	 •	 Dynamic deviation: analyse the deviation between two [2] bars 	
		  briefly

	 •	 Conditional formatting: find outliers by using rules for measures 	
		  or categories based upon rules

	 •	 Templates: choose from predesigned templates and save time

	 •	 Other features included are Error Bars, Preview Slider, Import / 	
		  Export Themes, Data Colours with IBCS Support, Ranking, and 	
		  more.

Business use cases include sales analysis, financial reporting and market 
research.

More on AppSource.
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Strip Plot by Nova Silva

The Strip Plot is an essential tool for uncovering patterns in categorical and 
numerical data, allowing users to visualise the distribution of individual data 
points effectively.  With the latest update, Nova Silva has supercharged the 
Strip Plot with powerful new features that enhance clarity and flexibility.

New in this update:

	 •	 Jittering: say goodbye to overlapping points! Jittering slightly 	
		  shifts data points to improve visibility, ensuring that every value	
		  in your dataset is accounted for
	 •	 Box plot: combine summary statistics with raw data by 		
		  overlaying a box plot on your Strip Plot.  Now, you can easily 	
		  spot medians, quartiles and outliers while maintaining full 		
		  visibility of individual data points
	 •	 Vertical layout: previously limited to horizontal orientation, the 	
		  Strip Plot now supports a vertical layout, making it even more 	
		  versatile for different analytical needs.

These enhancements empower users to gain deeper insights from their data, making trend identification and anomaly detection easier than ever.  
Try the updated Strip Plot in Power BI today and take your visual analytics to the next level.  You may download it now from the AppSource.

More next month.
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This month’s updates see Python in Excel now Generally Available to eligible Enterprise and Business users in Excel for the web and in Preview for 
Family and Personal users.  The TRIMRANGE function and other accompanying trim references are now available to all Windows users and iOS 
Insiders can now open shared files on iPhone and iPad without a Microsoft account.

Here is the list:

Excel for Windows

	 •	 TRIMRANGE and other accompanying trim references

Excel for Windows and web

	 •	 Python in Excel

	 •	 Copilot in Excel with Python

Excel for Windows and Mac

	 •	 Open shared Excel, PowerPoint and Word files on iPhone and iPad devices without a Microsoft account (Insiders).

Let’s get started.

TRIMRANGE and other accompanying trim references

We mentioned this nine months ago initially!  Microsoft has introduced a new function and a set of supporting references:

	 •	 the TRIMRANGE function: a function that removes empty rows and columns from the edges of a range.

	 •	 trim references: these offer a more succinct way to call common variations of the TRIMRANGE function.

This feature has now rolled out to all Windows Current Channel (CC) and Monthly Enterprise Channel (MEC) users.

TRIMRANGE scans in from the edges of a range or array until it finds the first non-blank cell (or value).  It then excludes those blank rows or 
columns.  It should be noted that TRIMRANGE and the associated new reference operators are not text functions, so they are not going to be 
useful for cell contents, such as line breaks or carriage returns.

The syntax is as follows:

TRIMRANGE(range, [trim_rows], [trim_columns])

It has three [3] arguments:

	 •	 range: this argument is required and represents the range (or array) to be trimmed

	 •	 trim_rows: this argument is optional and determines which rows should be trimmed by selecting one of four [4] values:

			   ○	 0: none
			   ○	 1: trims leading blank rows

			   ○	 2: trims trailing blank rows

			   ○	 3 (default if omitted): trims both leading and trailing blank rows

	 •	 trim_columns: this argument is optional and determines which columns should be trimmed by selecting one of four [4] values:

			   ○	 0: none
			   ○	 1: trims leading blank columns

			   ○	 2: trims trailing blank columns

			   ○	 3 (default if omitted): trims both leading and trailing blank columns.

In essence, the TRIMRANGE function removes empty rows and / or 
columns from the edges of a range.  This can be particularly useful when 
writing dynamic array formulae or optimising aggregation, array or 
lambda functions for performance.

We think TRIMRANGE may have missed a trick here in its initial Preview 
guise as we think of the TRIM function which removes excess space, not 

just at the beginning and end of a text string but throughout.  We can’t 
help feeling options to remove blank rows / columns throughout the 
range might be welcomed by many and feel there are many areas where 
this would be beneficial (e.g. charting, dashboards, summary outputs).

In the example below, TRIMRANGE has been used to calculate the length 
of any text entered into column A:

New Features for Excel
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The formula here is given by

=LEN(A1:A5)

However, we might wish to extend the range to add more words in column A, and this can lead to redundant calculations and possibly slower 
performance as the spreadsheet becomes more complex.

This is where the formula

=LEN(TRIMRANGE(A:A))

can come to the rescue and remove unused calculations (but reinstate them later if more text is added in column A):

Without the use of TRIMRANGE, 

=LEN(A:A)

Easy!
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would calculate for every cell in column C, returning over a million 
unnecessary results.  Besides being inefficient, trailing undesirable 
zeroes are returned to the grid.  This can be especially problematic if you 
then try and operate on the spill using =C1# notation.

TRIMRANGE is also a useful tool for optimising the performance of 
lambda functions that operate on ranges.  No doubt Microsoft has some 
particular scenarios in mind here (more new dynamic array functions 
soon possibly?).  It allows lambda authors to more tightly scope ranges, 
which can reduce the number of required computations.

We don’t have this function ourselves yet, but anecdotal evidence 
suggests this function will not work with three-dimensional references, 
but it does seem to work with arrays as well as ranges.  We shall do more 
testing as and when we can!

This new function has provided Microsoft with the opportunity to 
introduce Trim References, also known as Trim Refs.  These may be 
used to achieve the same functionality as TRIMRANGE more succinctly 
by replacing the range's colon ":" with one of the three Trim Ref types 
described below:

Full-column references are often avoided because they can have poor performance with some functions.  However, with Trim Refs, they are much 
more performant as the full-column reference can be constrained to just the portion with values.

Python in Excel is now Generally Available for Windows users of Microsoft 
365 Business and Enterprise.  It is also in Preview for Family and Personal 
users.  You may now create, edit and recalculate Python formulae in any 
workbook on your browser, along with Windows.

If you recall, last August, in partnership with Anaconda, Microsoft 
introduced an exciting new addition to Excel by integrating Python, 
making it possible to seamlessly combine Python and Excel analytics 

within the same workbook, with no setup required.  Since then, the 
feature has been extended with the advent of popular Python analytics 
libraries such as pandas, Matplotlib and NLTK to countless Excel users.

With Python in Excel, users may harness advanced analytics for 
visualisations, data cleaning, machine learning, predictive analytics and 
more.  Here are just some examples.

Advanced modelling capabilities in Python offer detailed and flexible 
optimisation analysis, such as Monte Carlo simulations.  These capabilities 
allow users to handle complex scenarios, providing deeper insights into 

their data.  For instance, here is an illustration depicting simulations 
analysis using Monte Carlo sampling for possible project expenses.

NetworkX is a powerful tool for creating and analysing complex networks, offering flexibility to model and visualise relationships between nodes 
effectively.  Here is an illustration using network models to view changes over time:

Type Example Equivalent TRIMRANGE Description

Trim All (.:.) A1.:.E10 TRIMRANGE(A1:E10,3,3) Trim leading and trailing blanks

Trim Trailing (:.) A1:.E10 TRIMRANGE(A1:E10,2,2) Trim trailing blanks

Trim Leading (.:) A1.:E10 TRIMRANGE(A1:E10,1,1) Trim leading blanks

Python in Excel

LEVERAGE PREDICTIVE ANALYTICS

VISUALISE NETWORK CONNECTIONS
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PARSE NATURAL LANGUAGE

The NLTK and word cloud libraries in Python provide robust tools for text analysis and visualisation.  NLTK excels in natural language processing tasks, 
while word cloud generates visually engaging representations of textual data, such as extracting and examining text to derive insights.
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MODERN EDITING

Copilot in Excel with Python

A great Python experience requires modern editing.  This includes 
new features like syntax highlighting, code completion and aid when 
referencing data with the xl() function - all of these have been added 
directly to the Formula bar.  Furthermore, Microsoft has recently 

announced the Python Editor, a new surface that is a great companion 
for authoring code and leverages many of the same experiences found 
in Visual Studio Code.  Here you may manage all your Python formulae 
from a single location.

Copilot users can use Copilot in Excel with Python to do advanced analysis 
as well.  This is now rolling out to Mac Insiders too.  With Copilot, you can 
use natural language to describe the analysis you want to perform and 
it will automatically generate, explain and insert Python code into your 
Excel spreadsheet accordingly.

This means you will be able to dive deeper into your data with Copilot in 
Excel with Python – yet know very little about Python!
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Open shared Excel, PowerPoint and Word files on iPhone and iPad devices without a Microsoft account (Insiders)

Microsoft is extending anonymous file sharing to iPhone and iPad.  Now, 
collaborators you've shared files with are able to open them on their 
iPhone and iPad devices, even if they don’t have a Microsoft account, 
although files shared using an Enterprise account will still require 
recipients to sign in.

When sharing files with others using your personal Microsoft account, 
recipients have been able to open them in Excel, PowerPoint and Word 
for the web even if they don’t have a Microsoft account.  This is now 

being extended to mobile applications.  Recipients are now able to open 
and view the contents of shared files in Excel, PowerPoint and Word 
on iPhone and iPad devices without signing in.  To make edits or leave 
comments, they will still need to sign in with a Microsoft account.

This means that you can now confidently share documents, worksheets 
and presentations from your personal Microsoft account and make them 
available for review with others while giving recipients a way to open 
and view the content on their mobile devices.

To implement:

	 •	 Make sure you are signed into your personal Microsoft account

	 •	 Open an Excel, PowerPoint or Word file that you want to share

	 •	 Select Share -> Link settings (the gear icon in the top-right corner), ensure that either the ‘Anyone with the link can edit’ or ‘Anyone with 	
		  the link can view’ option is selected, and then select the Apply button
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	 •	 To share the link with others, type their email address in the Share dialog box, and then click the Send button or else click the ‘Copy link’ 	
	 	 button and paste it in a message created using an app such as Microsoft Outlook or Microsoft Teams.

It should be noted that choosing the ‘Anyone with the link can view’ setting will allow users to view the content of the file but not edit, even if they 
are signed in.  When recipients open the link you shared with them, they'll be able to open and view the file even if they're not signed into the app.

File recipients, running Version 2.94 (Build 25020422) or later, will be able to open files anonymously using Excel, PowerPoint or Word on their 
iPhone and iPad devices.

Until next month.
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Imagine we toss an unbiased coin; half of the time it will come down heads, half tails.

It is not the most exciting chart we have ever constructed, but it’s a start.  

If we toss two coins, we get four possibilities: two Heads, a Head and a Tail, a Tail and a Head, and two Tails.  

In summary, we should get two heads a quarter of the time, one head half of the time and no heads a quarter of the time.  Note that (1/4) + (1/2) + 
(1/4) = 1.  These fractions are the probabilities of the events occurring and the sum of all possible outcomes must always add up to 1.

The story is similar if we consider 16 coin tosses say:

The A to Z of Excel Functions: PHI
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Again, if you were to add up all of the individual probabilities, they would total to 1.  Notice that in symmetrical distributions (such as this one) it is 
common for the most likely event (here, eight heads) to be the event at the midpoint.

Of course, why should we stop at 16 coin tosses?

All of these charts represent probability distributions, i.e. it displays how 
the probabilities of certain events occurring are distributed.  If we can 
formulate a probability distribution, we can estimate the likelihood of 
a particular event occurring (e.g. probability of precisely 47 heads from 
100 coin tosses is 0.0666, probability of less than or equal to 25 heads 
occurring in 100 coin tosses is 2.82 x 10-7).

Now, we would you to verify this last chart.  Assuming you can toss 100 
coins, count the number of heads and record the outcome at one coin 
toss per second, it shouldn’t take you more than 4.0 X 1022 centuries 
to generate every permutation.  Even if we were to simulate this 
experiment using a computer programme capable of generating many 

calculations a second it would not be possible.  For example, in February 
2012, the Japan Times announced a new computer that could compute 
10,000,000,000,000,000 calculations per second.  If we could use this 
computer, it would only take us a mere 401,969 years to perform this 
computation.  Sorry, but we can’t afford the electricity bill.

Let’s put this all into perspective.  All we are talking about here is 
considering 100 coin tosses.  If only business were that simple.  Potential 
outcomes for a business would be much more complex.  Clearly, if we 
want to consider all possible outcomes, we can only do this using some 
sampling technique based on understanding the underlying probability 
distributions.

If I plotted charts for 1,000 or 10,000 coin tosses similar to the above, we 
would generate similarly shaped distributions.  This classic distribution 
which only allows for two outcomes is known as the Binomial distribution 
and is regularly used in probabilistic analysis.

The 100 coin toss chart shows that the average (or ‘expected’ or ‘mean’) 
number of heads here is 50.  This can be calculated using a weighted 

average in the usual way.  The ‘spread’ of heads is clearly quite narrow 
(tapering off very sharply at less than 40 heads or greater than 60).  This 
spread is measured by statisticians using a measure called standard 
deviation which is defined as the square root of the average value of 
the square of the difference between each possible outcome and the 
mean, i.e.

Probability Distributions
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where:	 σ = standard deviation

	 N = total number of possible outcomes

	 Σ = summation

	 xi = each outcome event (from first x1 to last xN)

	 μ = mean or average

The Binomial distribution is not the most common distribution used in probability analysis: that honour belongs to the Gaussian or Normal 
distribution:

The Central Limit Theorem states that the sampling distribution of the 
sample means approaches a normal distribution as the sample size gets 
larger — no matter what the shape of the population distribution.  This is 
why this distribution is so important in probability and statistics.

Generated by a complex mathematical formula, this distribution is 
defined by specifying the mean and standard deviation (see above).  The 
Normal distribution’s population is spread as follow:

i.e. 68% of the population is within one standard deviation of the mean, 95% within two standard deviations and 99.7% within three standard 
deviations.

The formula for the Normal distribution is given by

Fascinating, I know.  There is a special version of this called the standard Normal distribution (or the z-distribution) which is the Normal distribution 
with mean zero [0] and standard deviation one [1].  Furthermore, probability density functions are a statistical measure used to gauge the likely 
outcome of a discrete value (e.g. the price of a stock).
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The PHI function in Excel returns the value of this density function for a standard Normal distribution.  It has the following syntax:

=PHI(x)

It has just one argument:

	 •	 x: this is required and represents the number for which you want the probability density of the standard Normal distribution.

It should be further noted that:

	 •	 if x is a numerical value that is not valid, PHI returns the #NUM! error value

	 •	 if x is using a data type that is not valid, such as a nonnumeric value, PHI returns the #VALUE! error

	 •	 this function originated in Excel 2013 and is not backwards compatible with earlier versions of Excel.

Please see our example below:

The A to Z of Excel Functions: PHONETIC
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Nope, it’s nothing to do with that image (and it’s not a type of phone 
energy either).  Excel’s PHONETIC function may be used to extract the 
phonetic (furigana) characters from a text string containing Japanese 

characters.  This function is particularly useful for users working with 
Japanese text, as it helps in understanding the pronunciation of the 
characters.  A basic understanding of Japanese is assumed!

To use the PHONETIC function, your region setting must be one of the Far East languages (Japanese, Chinese and Korean).

The PHONETIC function has the following syntax:

=PHONETIC(reference)

It has just one argument:

	 •	 reference: this is required and represents a text string or a reference to a single cell or range of cells that contain a furigana text string.

It should be further noted that:

	 •	 if the reference is a range of cells, the furigana text string in the upper-left corner cell of the range is returned

	 •	 if the reference is a range of nonadjacent cells, the #N/A error value is returned.

Please see our examples below:

The number π is a mathematical constant that is the ratio of a circle's 
circumference to its diameter, approximately equal to 3.14159.  The 
number π appears in many formulae across mathematics and physics.  It 
is an irrational number, meaning that it cannot be expressed exactly as a 
ratio of two integers, although fractions such as 22/7 are commonly used 
to approximate it.  Consequently, its decimal representation never ends, 
nor enters a permanently repeating pattern.  It is also a transcendental 

number, meaning that it cannot be a solution of an equation involving 
only sums, products, powers and integers. The transcendence of π 
implies that it is impossible to solve the ancient challenge of squaring the 
circle with a compass and straightedge.  The decimal digits of π appear to 
be randomly distributed, but no proof of this conjecture has ever been 
found.  But you can find it in Excel.

The PI function returns the number 3.14159265358979, the mathematical constant π, accurate to 15 digits.  It has the following syntax:

=PI()

It has no arguments but requires the parentheses to distinguish at as an Excel function.

The A to Z of Excel Functions: PI
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It should be further noted that:

	 •	 we have nothing else to say about it.

Please see our final examples for this month below:

More Excel Functions next month.

The challenge this month was to transform data into a useful Table.  Did you succeed?

The Challenge

This month, we had a Power Query challenge.  We received some expense information in an Excel workbook which is not in a format that is 
compatible with our usual layout.

Therefore, this month’s challenge was to extract the data from a sheet in the supplied Excel workbook and present it in a Table that can be appended 
to other expense data.  The result should look like the Table below:

Note: Our dates are in UK format – this was not part of the challenge!

As always, there were some conditions:

	 •	 this was a Power Query challenge: no Excel formulae allowed

	 •	 the solution should allow us to add more expenses

	 •	 the solution should need less than 10 steps (one transformation per step)

	 •	 All the steps can be achieved using the User Interface (UI) from one query.  No M code was needed.

Beat the Boredom Suggested Solution
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Suggested Solution

We start by extracting the data.  We can select the data and right-click to ‘Get Data from Table/Range’.  This will also convert our data into a Table:

This gives us a query, which we rename to Expenses:

The ‘Changed Type’ step has not achieved anything as our data is currently mixed in the columns.  We can remove this step.  We have two tasks.  
We need to extract the date, and we need to format the expenses.  We start by extracting the date: we right-click on the cell containing the date:

We choose ‘Add as New Query’ which creates a query called Column2 with only two [2] steps: 
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We didn’t say we couldn’t create another query, only that all the steps had to be created from one query!  [Cheat, cheat – Ed.]

In the Expenses query, we choose ‘Keep Rows’ and then ‘Keep Bottom Rows’ from the Home tab.

We choose to keep two [2] rows.  This leaves us with the expense data:

We choose ‘Use first row as headers’ from the Home tab:

This generates a ‘Changed Type’ step, which we delete as we are about to select all the data and ‘Unpivot Columns’ from the Transform tab:
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Now, we can add the date by using ‘Custom Column’ from the ‘Add Column’ tab:

We choose the Column2 query and create the new column Date.

Now we just need to tidy up.   We rename the columns and assign the correct data types:

We have our solution in nine [9] steps!  

We choose ‘Close & Load To…’ from the Home tab so that we can put Expenses on the same sheet as the data, and keep Column2 as a ‘Connection 
Only’ query:
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Finally, we show that more expenses can be added:

Did you have a better solution?  Let us know, we’d be glad to hear if there are better ways to work around this problem!
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

contact@sumproduct.com
www.sumproduct.com
+61 3 9020 2071

Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This time, we thought we would look 
at some of the keyboard commands on their own:

Keystroke What it does
Backspace Edit and clear
Delete Clear
Down Move down one cell
End Toggle End mode
ENTER Enter value and move down (by default)
ESC(APE) Cancel (edit, copy, cut, dialog, etc.)
Execute Enter value and move down (by default)
Help Help
Home Select the first cell in the row
Insert Toggle Overwrite mode in Edit mode
Left Move left one cell
Page Down Page down
Page Up Page up
RETURN Enter value and move down (by default)
Right Move right one cell
Subtract (-) Extend Selection mode
TAB Tab forwards (next cell to edit)
Up Move up one cell

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at http://www.sumproduct.com/
thought/keyboard-shortcuts.  Also, check out our new daily Excel Tip of the Day feature on the www.sumproduct.com homepage.
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